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Pittsburgh STC WorkQuestTM Group Presented at
Region 4 Conference

On Saturday, November 9, five members
of the Pittsburgh Chapter STC
WorkQuest

TM

 group presented the session
“Smart Job Searching” at the 2002 Region
4 Conference in Columbus, Ohio.  Capsules
of these presentations follow, and hand-
outs are posted on the STC WorkQuest

TM

Web site.

The  P i t t sburgh  STC WorkQues t
TM

group presenters hope you’ll find our
presentations helpful no matter where
you are on your career path, and we
thank the Pittsburgh Chapter STC and
Nancy Carpenter for financial contri-
butions that significantly defrayed our
costs for attending the Conference and
presen t ing  the  P i t t sburgh  STC
WorkQuest

TM

 initiative to our Region.

About Pittsburgh STC WorkQuestTM -
Janis Ramey
Group founder and Region 4 Conference
session moderator Janis Ramey reviewed
how Pittsburgh’s STC WorkQuest

TM

 group
developed and where it stands today.
Janis got the idea for this support group
for technical communicators looking for
work from the experiences of a friend, an
article she wrote on the topic, and
outplacement functions offered by some
companies.  She obtained the blessing of
the Pittsburgh Chapter STC to start this
initiative in order to motivate members and
help them focus on specific tasks and is-
sues of job searching.

Those attending STC WorkQuest
TM

meetings include STC members who
have been laid off, contractors and

freelancers whose business is down,
non-STC technical communicators, re-
cent graduates, people who want to
enter the technical communications
field, and other professionals.  Al-
though Janis expected that the group
would attract mostly laid-off relatively
young writers who were inexperienced
in job searching, those attending the
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President’s Column
I had the privilege of traveling to Colum-
bus, Ohio on a mild November weekend
to attend the Region 4 STC Conference
and Leadership Day. At least eight mem-
bers of the Pittsburgh chapter attended
the conference. Total attendance was
more than 100. For only $85, attendees
heard a day of sessions by speakers from
the 2002 STC international conference. It
was an outstanding value, especially in
light of today’s tight travel and training
budgets.  This issue of the Blue Pencil
contains several articles about various
conference presentations.

The presentation by the Pittsburgh
chapter’s own WorkQuest group was a high-
light of the conference. Janis Ramey, John
Clark, Mary Ann Pike, Jim McCarty, and
Diana Mathis each gave a presentation on
some topic relating to finding work.  Even if
you didn’t make it to Columbus, you will
have a chance to hear each of their presenta-
tions at the December 10 chapter meeting.

Their advice and insights are valuable to
everyone, not just active job-seekers.

In other chapter news, I’m pleased to an-
nounce that Nicky Bleiel has agreed to take
over the position of Membership Commit-
tee Manager from outgoing manager Nancy
Pearson. You can contact Nicky by email to
nableiel@software.rockwell.com. Nicky’s
responsibilities range from welcoming new
members to creating a strategic plan for
doubling the membership of the Pittsburgh
chapter within the next three years.

In all seriousness, membership remains a
significant issue for the Society at the in-
ternational level. Total membership is down
significantly due to the current economic
malaise. We will be working at the chapter
and regional levels to increase member-
ship in the coming months.  Membership
in the STC costs approximately the same
amount as five or six large pizzas. Please
consider this value when you receive and
act on your membership renewal notice
for 2003.

Identity Crisis: How Can We
Increase the Demand for Technical
Communicators?
By Meg Papa

It isn’t news that the job market is currently
a bit lean.  As the popularity of the chapter’s
WorkQuest group attests, technical com-
municators are not exempt from the effects
of the weak economy.  How can we, as tech-
nical communicators, find — and keep —
employment?  We can spend a lot of time
and effort marketing ourselves, or, as Greg
McCormick suggests, we can elevate the
visibility and credibility of our profession
as a whole.

McCormick, an information and curricu-
lum designer at North American Logistics,
gave a lively and humorous talk on this
topic at the Region 4 Conference on No-
vember 9.  He firmly believes that the STC,
its chapters, and its members have to work
together to raise the profile of technical

communicators in the workplace.  He viv-
idly demonstrated how little people know
about technical communicators by listing
several questions one could ask about a
profession, including: What is the person
doing? What does the person wear? What
education and training is needed? What is
the work environment like?  He then named
several professions: Nurse, Construction
Worker, Swash-Buckling Pirate, Starship
Captain, and Crime-Fighting Super Hero.
A humorous list to make a serious point:
more people can answer the questions for
these professions than can answer them
for a technical communicator.  He asks,
“Does the average John Q know what we
do?  Most people are clueless.”  This is a
problem — one that the STC can address.
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(continued on page 9)

Employment Issues Column: Marketing Yourself
By Pam Schmidbauer

Area Manager, Aquent

While looking for employment you become
a marketing specialist – and the product is
you. Here are some tips to keep in mind
while marketing yourself.

Know The Product - You
What are your work values, goals, inter-
ests, and skills? What are your strengths
and weaknesses?

Develop a Good Sales Tool - Your Résumé
and Cover Letter
These resources should accurately reflect
you — your goals, accomplishments, and
your style. They should be brief and con-
cise. The résumé and cover letter should be
focused toward the type of industry and/or
company of interest. As a sales tool, they
will be influential in securing an interview.

Identify and Research Your Market
Think about what you want to do and start
a priority list. Identify organizations most
desirable to you and best suited to your
talents and values.  There may be many

alternatives. Utilize company literature and
conduct exploratory interviews.

Advertise
Let everyone know that you are available.
Since fewer than 12 percent of job hunters
find jobs through ads and five percent
through employment agencies, it is impor-
tant that you be active in making personal
contacts and letting others know of your
skills.

Develop a Referral Network
The most effective way of securing a posi-
tion is through making personal contacts.
To take advantage of this fact, you have to
build a referral network. You need to try to
identify the people you already know and
the people you could meet who would be
able to refer you to open positions. This is
important because a face-to-face encournter
means more and lasts longer than any let-
ter, phone call, or résumé.  Develop a list of
people you know - relatives, friends, former
co-workers, faculty, and schoolmates can
all be valuable.

• Make sure the people on your list are

aware of your skills and of the job
search you are undertaking. Some of
these people may be willing to write
you letters of reference should you
need them.

• Give each person a copy of your
résumé.

• Keep records of your conversations
and the information you’ve received.

• Make a second list of referrals for
people you have not  met. For instance,
a writer may contact someone who is a
communications manager.

• Build your list by looking at organiza-
tions in which you are interested and
finding out who would be the respon-
sible manager in that area. Contact and
visit these organizations.

Keep Records
A log is an excellent way to keep your job
search organized. For every contact you
make, fill out a log sheet with all the perti-

Single Source Text with Word—Sort Of
By Robert P. Mohr

The ability to single-source text for reuse in
multiple documents has become a hot topic
in recent years. Word has had this capabil-
ity, to some degree, for some time, and it
can be done with any of five methods:

1. Insert > File > Range

2. Insert > File

3. Insert > Object

4. Paste Special

5. Merge

Though methods 1 through 4 all have ad-
vantages and disadvantages, the concept
of how to use them is basically the same:
Text (in whole or in part) from one or more
source files is linked or copied into a target
document. Method 5 is a completely differ-
ent animal.

Suppose the target document is a proposal.
Folks in HR maintain the biographies on
key personnel that you can link into your
document. Likewise, the cost and technical
sections are also created by others and also
linked into your document. Which of the 5
methods is best?  As always, it depends.

1. Insert > File > Range
The advantage to this method is that it re-
lies on bookmarked text in the source files.
This is good when the source file is lengthy,
acting as a container for many chunks of
text, tables, graphics, etc. Each chunk is
encapsulated by a bookmark. You can also
specify the connection between the two files
to be dynamic. Pressing F9 refreshes the
link to the bookmarked text and assures your
target document is current. The disadvan-
tage to this method is that you must know
the name of the bookmark you’re linking to

prior to establishing the link. Here’s the pro-
cedure for using method 1:

1. Open the target document and posi-
tion the insertion point where the
source text is to be inserted.

2. Select Insert > File.

3. Select the source file and click the
Range button.

4. Type the name of the bookmark encap-
sulating the text you want.

5. Select Insert as link from the Link
drop-down list. Word copies the text
into the target document.

6. At any time you can highlight the text
and press F9 to refresh it.

(continued on page 12)
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People News
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Region 4 Conference Provides
Information on Upgraded Tools
By Mary Ann Pike

On Saturday, November 9, I attended the
2002 Region 4 Conference in Columbus,
Ohio.  In addition to the session I presented
along with four other members of the Pitts-
burgh STC chapter’s WorkQuest

TM

 group
(see article on page 1), I attended two of the
sessions on recently upgraded document
development tools. I found both sessions
to be very informative.

Dreamweaver MX
Since Macromedia released Dreamweaver,
it has been my webpage editor of choice.
And Macromedia’s recently released MX
version represents a marked improvement
over previous versions of Dreamweaver.
The GUI is superior and provides even
more automated entry of various HTML
command attributes.  Along with many
other features, the MX version includes
good support for cascading style sheets,
a selection of predefined buttons created
from Fireworks, and easy integration of
code from other web development pro-

grams. Michael Starr, the webmaster of the
STC Central Ohio Chapter presented this
very informative session.

FrameMaker 7
FrameMaker is another of my favorite tools,
which I have been using since version 1.3.
Adobe representatives gave an overview of
the structured document support added to
FrameMaker 7 and of the collaborative features
in Adobe Acrobat 5. FrameMaker 7 supports
the development of XML documents and has
the capability to easily develop your document
type definitions (DTD). It allows you to gener-
ate print or pdf documents and edit your XML
structures. FrameMaker 7 includes some basic
formatting templates, and allows you to specify
output templates that you’ve developed us-
ing another tool. Acrobat 5 has some powerful
collaborative reviewing capabilities which al-
lows you to put a file out for review and have
the reviewers attach annotating comments or
entire files. Multiple reviewers are able to view
and update the comments simultaneously.
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Break Through the Single-Source Roadblock
By Nancy Carpenter

Jesse Wiles, consultant to Quadralay Cor-
poration in Austin, Texas, was the featured
speaker at the November 6 chapter meeting.
Jesse described single sourcing, then dem-
onstrated the capabilities of WebWorks
Publisher. Single-sourcing is the re-use of
information in different formats for different
purposes. The source document is not
changed, but the output is customized for
the specific audience and medium. No post-
processing is needed.

Quadralay developed WebWorks Publisher
to provide a single-sourcing tool for
FrameMaker and Word documents. It is tem-
plate-based and requires that the author use
the styles in the source software. The author
selects the template for the desired format.

WebWorks then maps the source document
styles to the template to convert the docu-
ment to the online format. The template can
be changed in the same way that styles can
be changed in the source software.

WebWorks Publisher can produce a vari-
ety of online formats. FrameMaker docu-
ments can be converted to HTML,
JavaHelp, XML, XHTML, Accessible
HTML, WinHelp, and all industry-standard
online help systems. Word documents can
be converted to HTML Help, JavaHelp,
WinHelp, and WebWorks Help.

For large writing departments, Quadralay also
provides two support programs —
WebWorks AutoMap, which performs batch
document conversion on a scheduled basis;
and WebWorks AutoMap Client, which puts

a WebWorks dropdown menu on the
FrameMaker menu bar for use in conversions.
Oracle Corporation, BEA Systems, Excelon,
Cognos, Agilent, and Cadence now use
WebWorks AutoMap Client.

You can download a demonstration version
of this software.

Quadralay was formed in 1992 as a developer
of search engines. They noticed a need to pub-
lish online from FrameMaker and developed a
conversion package to assist their writers. This
is now marketed as WebWorks Publisher.
Quadralay provides several services related
to WebWorks Publisher — on-site training,
WebWorks University, consulting, coaching,
and support. For more information, see:
www.webworks .com,  or  emai l  a t
info@webworks.com.

WorkQuest
TM

 Group Going Strong
By Mary Ann Pike

The Pittsburgh Chapter’s WorkQuest
TM

group continued its weekly meetings in Oc-
tober.

October 8: Career Coaching – Jane Duffy
Featured guest speaker Jane P. Duffy’s ca-
reer focus is career management and coach-
ing. She is a career coach at the University
of Pittsburgh’s Katz School of Business,
works for an outplacement firm, and is de-
veloping her own business (Work in Faith)
to help people connect their faith with their
career.

During a period of extended unemployment
in her own life, Jane realized that it can be
hard to determine what daily activities you
should plan to further your job search. She
said that the amount of time you spend on
your job search should be in the neighbor-
hood of 30 hours each week. You need to
try to spend those hours in a manner most
constructive to your job search.

She explained that unsolicited direct mail
only has about a three percent rate of re-
turn, and is usually not worth the effort.
The Internet is a major recruiting source for
companies right now, but might not be as

useful as you think. Companies are receiv-
ing such a large volume of résumés for each
job posted, that they are looking at the
résumés in the order they receive them, tak-
ing the first eight or ten that look promis-
ing, and ignoring the rest. Search firms are
not a very good source of leads at this point
in time, either, since they are overwhelmed
with people looking for work. Jane stressed
that these three methods of finding work
should constitute the smallest percentage
of your job search.

Networking is considered to be the most
successful job hunting activity. Network-
ing is any conversation you have with some-
one about your job search. It can be with
an acquaintance, a contact in a company
you’ve targeted as a place you’d like to
work, or a hiring manager in a department
that has a job opening. Jane suggests a
goal of speaking to 20 or 30 new people
each week about your job search. She says
that speaking to eight to ten new people is
a good accomplishment. For someone who
doesn’t have a lot of contacts, she sug-
gests discussing your job situation with
everyone you know – your hairdresser, your

auto mechanic, church members, fellow
hobbyists – you never know who might
know of someone that has a position ap-
propriate to your skills. As an exercise, write
a 30-second summary of yourself and prac-
tice giving it to people.

Jane explained that you should have a mar-
keting plan because you’re selling your-
self, just as a company selling a product
would have a marketing plan. Your plan
should have:

• An objective – the type of work you
want, possible job titles

• Qualifications and key accomplish-
ments – brief summary of what you’ve
done and what you have to offer

• Target market – geographic area where
you want to work, industry or type of
organization you want to work for, size
of the organization, any other criteria
important to you

(continued on page 10)
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Pittsburgh STC WorkQuest
TM

 group have
been mostly experienced people and
have included several from other pro-
fessions, such as sales and information
technology.

The group meets every Tuesday at 10
a.m. – early enough to get everyone go-
ing and late enough to miss rush hour
traffic.  The meeting place moves around
the Pittsburgh area each week to provide
variety and the opportunity to become
familiar with various areas of the city and
suburbs.  Attendance averages 10 to 12
of a total roster of about 25.

The Pittsburgh STC WorkQuest
TM

 presen-
tation at the Region 4 Conference session,
“Smart Job Searching” modeled a weekly
STC WorkQuest

TM

 session.  Each session
starts with a “check-in round” in which at-
tendees (newcomers and “established”
members) reiterate their job search
objective(s) and report on their past week’s
job-related activities and results.  After pre-
senters reported, many members of the small
but focused group of session attendees
also “checked in” and handed out their
business cards/marketing materials.

In addition to a professional activity each
week, STC WorkQuest

TM

 meetings provide
outlets for attendees to demonstrate and
develop their professional expertise.  So,
following the “check-in round” at the Re-
gion 4 Conference, each of the four addi-
tional STC WorkQuest

TM

 presenters gave a
very condensed version of presentations
they had developed for STC WorkQuest

TM

meetings this fall.  The presenters have
encapsulated their presentations below.

Sell Yourself Effectively – Mary Ann Pike
In her presentation, Mary Ann touched on
a number of tasks that need to be completed
to prepare for a job search.  She listed the
following:

• Develop a personal marketing plan

• Create an effective résumé

• Write effective cover letters

• Build an impressive portfolio

• Work with recruiters and agencies

• Use the Internet to further your job
search

Mary Ann then focused her presentation
on résumés, providing a brief overview of
her article in last month’s Blue Pencil, and
on Internet job searching.

Mary Ann noted that in today’s market, the
average human resources person spends
only 20 seconds evaluating a résumé.  She
provided many tips for getting your résumé
noticed which covered organization, con-
tent, and format.  She gave excellent advice
about how to use your résumé to best ad-
vantage in your job search.

In the second part of her presentation,
Mary Ann shared tactics for successful
use of the Internet in your job search.
Internet searches can focus on job search-
ing, information gathering on companies
and locations of interest, or general and/
or specialized education to increase your
value.  Mary Ann discussed a number of
ways to get the most out of each type of
search.

Finding Opportunities – Jim McCarty
Jim McCarty talked about how we go about
finding those elusive jobs in this very tough
job market.

He noted that conventional approaches to
job searching, such as using the Internet,
reading want ads, talking with headhunt-
ers, recruiters and temp agencies, put us in
touch with only 20 to 25% of the jobs that
are out there. The other 75 to 80% are never
advertised!  These jobs are uncovered
through networking.

Networking was an important part of the
presentation.  Jim talked about the im-
portance of getting ready to network,

making networking contacts, and getting
and conducting yourself during a net-
working interview.  He emphasized the
difference between a networking inter-
view (to gather information and referrals)
and a job interview (to sell yourself into
the job).

Jim also discussed the Hiring Life Cycle,
or the process companies go through from
recognizing the need to hire someone, to
actually bringing someone aboard to fill
that position. He explained that the earlier
you can infiltrate the Hiring Life Cycle, and
get in front of the people who can hire
you, the greater your chances are of get-
ting the job. Networking provides great
opportunities for such infiltration.

His closing remarks hit home with every-
one who is looking for work.  Looking
for work is a full time job.  If you are
spending less than 40 hours a week look-
ing for work, you are short-circuiting your
employer.  Who is your employer when
you are unemployed?  YOU, of course.

Nurturing Yourself – Diana Mathis
Job crises or losses are special opportuni-
ties to nurture ourselves professionally and
personally.  Attitude is vital: think and act
“newly self-employed,” not unemployed.
Adopt an active, not a passive approach to
the freedoms and responsibilities of your
new job.  Who knows, you may decide to
remain self-employed!

Objectives of your new position include
taking charge of your finances and budget-
ing to meet the physical and medical needs
of yourself and your family, deciding what
path your career will take, and honing psy-
chological and emotional coping skills to
maintain equilibrium in this time of high
stress.  Three points to remember about
coping:

Pittsburgh STC WorkQuestTM Group Presented at
Region 4 Conference

(continued on page 7)

(continued from page 1)
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1. Life is stress; stress is life.

2. People respond to stress in different
ways.

3. We need to learn and practice coping
skills to manage stress.

Life is stress.  Dr. Hans Selye, a medical
specialist in endocrinology, noticed that all
illnesses have similar basic symptoms, such
as feeling/looking sick, aches and pains,
digestive upset, fever.  These symptoms,
due to hormonal changes, can be triggered
by physical stress (a cold) or psychologi-
cal stress (job loss).  Physical reactions to
increased stress include increased heart
rate, breathing rate, blood pressure, muscle
tension, and stomach acid.  Chronic excess
stress leads to high blood pressure, sleep
disorders, chronic headache or other pains,
exhaustion, more infections, and, in those
who are predisposed, illnesses such as dia-
betes, heart disease, arthritis, and cancer.
Mental reactions to chronic stress include
psychological exhaustion, lethargy, depres-
sion, and anxiety.

People respond to stress in different ways.
To be alive is to experience stress, but as
Selye said, “The same stress which makes
one person sick can be an invigorating ex-
perience for another”.  Know yourself.
Know how you respond physically, men-
tally, and socially to excess stress.

Learn and practice coping skills.  Tactics
to control physical symptoms of excess
stress include breathing and relaxation ex-
ercises.  Mental coping skills include using
imagery and silently reciting a personal
verse or mantra.  Learn to use tactics such
as silence or a stock phrase to defuse stress
in a social interaction.  Prevent the build-up
of chronic stress by following a healthy diet
and regularly participating in physical exer-
cise, stress-relieving leisure activities, and
conversations with supportive friends.

Hone your coping skills now - you never
know when you will be contacted about a
new job, called for an interview, or win the
lottery!

Presenting Yourself – John Clark
In his presentation, John focused on the
key points to a great interview:

• Think straight

• Do your homework

• “Swing the bat”
Thinking straight means that how you
think about interviewing can make all the
difference between a successful interview
and one that doesn’t go so well.  Part of it is
realizing that the most qualified people
don’t necessarily get hired; the most pre-
pared usually do.  Thinking about interview-
ing as a game, a dance, or a play can help
with the mental preparation.  You realize then
that you need to know how the game is
played in order to do well.

Doing your homework involves prepar-
ing and researching four key areas.  First,
learn about the interviewing process it-
self.  Research the typical questions that
interviewers ask.  And for that, John rec-
ommends two books: Knock ‘em Dead
by Martin Yate and Job Interviews for
Dummies by Joyce Lain Kennedy.  Both
books help you by providing the tough
questions that will most likely be asked,
along with how to give good answers that
are tailored to your specific situation.

The second area where you need to do
your homework is about yourself. Turn
your skills and accomplishments into sto-
ries and examples that show how you
helped the company make money, save
money, or save time.  You’ll use these sto-
ries to amplify and support your answers
to the tough questions.

The third area of preparation is in finding
out about the company.  Find out what’s

Pittsburgh STC WorkQuestTM Group Presented at
Region 4 Conference
(continued from page 6)

important to it by researching it through
the Internet, newspapers, and business
articles.  Plan to use this information in
your answers.

The last area of homework is about the job.
Before you go on the interview, find out
about the job’s scope and responsibilities,
typical projects, and anything else that will
help you match your skills and accomplish-
ments to the job you’re applying for.

In order for all of this preparation to do
you any good, you’ve got to “swing the
bat.”  Just as professional sports players
routinely practice to stay at the top of their
game, you need to do the same for your
main event.  It isn’t enough to think about
the answers.  You’ve got to actually say
the answers.  There’s no substitute for role
playing with a friend or associate in a mock
interview.

Follow these guidelines and you’ll have a
great interview.

For more information
Pittsburgh’s STC WorkQuest

TM

 group has
its own Web site, developed, hosted, and
managed by Tod Pike, who posts materi-
als almost instantly.  In addition to pre-
sentations by WorkQuest

TM

 members at
weekly meetings, the site’s “Documents/
Articles” directory has copies of the hand-
outs prepared by each of the five present-
ers at the Region 4 Conference.  Check out
the wealth of info. for career management
at http://home.earthlink.net/~workquest/.
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He then went on to suggest ways that the
STC and its members can advertise and ex-
plain our profession, and link our supply
with the demand in the workplace.  He clas-
sified these options as being the responsi-
bility of the STC, the individual, or a coop-
erative effort between both.

Action items for the STC

• Buy radio and television commercials.

• Buy advertising in print media.

• Send brochures to the headquarters of
major organizations.

• Develop a professional vocabulary.
(Should we outlaw certain words?
What about phrasal verbs?)

• Provide Certificate of Membership
(Member in Good Standing since…).

• SIGs should create publications to pub-
licize and standardize our profession:
o Create informational brochures

(MarCom SIG).
o Develop standard PowerPoint

presentations that members can
download and use for events and
visits (MarCom SIG).

o Develop a “Profitability-Value
Line” for the various services of
our profession (Management
SIG).

o Develop a best practices method-
ology and document (Procedures
SIG).

o Collect data on productivity for
the profession, such as hours-
per-page for a user manual,
minutes-per-page to edit, hours
to develop a training program,
etc. (various SIGs).

o Develop and make available a tem-
plate library for various docu-
ments, web pages, etc. (InfoDesign
SIG).

o Develop a Usage Guide for style,
vocabulary, punctuation, etc. (Us-
ability SIG).

Action items for individuals

• Talk about our profession and what you
do – constantly!

• Attend business and academic events.

• Give newspaper or magazine interviews.

• Ask web-based job sites to add “techni-
cal communicator” to their dropdown lists.

• Create a library of explanatory and ex-
emplary material of what you do.

• Pay attention to how you “brand”
yourself (business card, letterhead,
website, etc.).

• Show respect for your profession and
your audience.

• Exhibit the STC Ethics statement in
your office and discuss it in your con-
versations.

• Remind yourself that “You are a Sub-
ject Matter Expert.”

•· Display evidence in your workplace
of your training, certifications, mem-
berships, testimonials, reference
tools, professional periodicals, etc.

• Develop a three-second, 30-second,
and three-minute introduction of your-
self and your profession.

Action items needing cooperation

• Work to add “technical communica-
tion” to business surveys, newspaper
classifieds.

• Identify the demographics of markets
that employ us.

• Build profiles of companies that hire
technical communicators.

• Determine salaries by specialty and
region.

• As a chapter, staff a phone bank for a
public TV fund drive.

• Participate in job fairs and career days
as representatives of the profession,
not of our employers.

• Educate employment recruiters – they
have to know what we do to represent
us accurately to potential employers.

• Talk to Chambers of Commerce and
City/County officials to get “technical
communicator” listed on their
websites.

• Get involved in STC events at all
levels.

Some of these suggestions, such as ex-
hibiting the statement of STC Ethics, may
seem odd, until you compare it to common
practices in other professions.  McCormick
asked, “Would you go to a doctor who
didn’t have an AMA membership [certifi-
cate] on his wall?”  Likewise he asks,
“Other professions have SOPs [standard
operating procedures]; why don’t we?”

He also talked about the need to change
our mindset when we represent ourselves.
We should think (and talk) of ourselves as
members of a profession first, an employee
of our organization second.  We need to
“be verbal billboards for our profession”
and represent ourselves as professionals
and experts at all times.  We all have a theme
we project, whether we know it or not, and
it is important for each of us to figure out
our own theme.  His professional theme is
“I explain technology to people who need
to use it.”  The theme for his talk was that
we have to take our profession seriously
before anyone else will.

Identity Crisis: How Can We Increase the Demand
for Technical Communicators?
(continued from page 2)
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2. Insert > File
The advantage to this method is that it does
not rely on bookmarked text in the source
files. This is good when the source files are
themselves individual chunks of text, tables,
graphics, etc. This method also uses dy-
namic links. The disadvantage to this
method is that unless the content of a
source file is exactly what you want, you
may get more than you really need and will
have to manually delete excess content.
Here’s the procedure for using method 2:

1. Open the target document and posi-
tion the insertion point where the
source text is to be inserted.

2. Select Insert > File.

3. Select Insert as link from the Link
drop-down list. Word copies the file
into the target document.

4. At any time you can highlight the in-
serted text and press F9 to refresh it.

3. Insert > Object
This method is a variation on the previous
method. The advantages and disadvan-
tages are basically the same. Here’s the pro-
cedure for using method 3:

1. Open the target document and posi-
tion the insertion point where the
source text is to be inserted.

2. Select Insert > Object.

3. Click the Create from File tab.

4. Click Browse and select a file using
the dialog box.

5. Click the Link to File check box to es-
tablish the link. Word copies the file
into the target document.

6. At any time you can highlight the in-
serted text and press F9 to refresh it.

4. Paste > Special
This method is probably the most familiar.
Everyone knows how to copy and paste,
right? The advantage to this method is that
it’s simple and visual. You see what you’re

selecting. The disadvantage to this method
is that you have to open the source file
then close it again after you glean what you
want from it. Here’s the procedure for using
method 4:

1. Open a source file and select the con-
tent you want to copy.

2. Select Edit > Copy.

3. Open the target document and posi-
tion the insertion point where the
source text is to be inserted.

4. Select Edit > Paste Special.

5. Select Microsoft Word Document Ob-
ject in the As list box.

6. Click the Paste Link radio button.

7. Click OK.

8. At any time you can highlight the in-
serted text and press F9 to refresh it.

5. Merge
By merge, I’m referring to merging a Word
document to a database. This method is
the most powerful and the most complex.

Records in the database take the places of
source files used by the other methods.
There are several advantages to a using a
database:

• Content is organized and uniform.

• Database records are easily queried
and sorted.

• Speed. Merging a Word template con-
taining established merge fields to a
database is by far the fastest way to
generate a new document with up-to-
date content.

• Reliability. There is less chance of
error when merging to a database
because there is less manual input
required.  Select ing the proper
records and data fields is simpler
than remembering and manually
typing many bookmark names.

There are also disadvantages:

• If you don’t know how to create a
database, or don’t have access to
someone who does, you’ll have to
learn. (Not to worry! Starting next
month, I’ll write a 4-part series on
creating an Access database.)

• You’ll have to make the database ac-
cessible to your contributing authors
so they can maintain their content in
the database.

• As you may be unfamiliar with data-
bases, so might your contributors. You
may have to train them in the use of
database forms and editing content.

Here’s an overview of how to merge with a
database to generate a document:

1. Create a database comprised of one or
more tables containing the content you
need.

2. Create a Word document (or template)
for the merge.

Single Source Text with Word—Sort Of
(continued from page 3)

(continued on page 10)
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• List of specific companies you want to
target – try to get name of people to talk
to target -- try to get the names of people
to talk to within those companies

Jane gave the group a handout (which is
on the WorkQuest website) that listed key
criteria to use in tracking your job search,
contained a chart you can use to track your
job search activities, and provided a tem-
plate for writing a marketing plan.

In order to keep your job search on track,
Jane suggested keeping a daily log your
job search activities. She stresses that
you need to evaluate your activities, and
if you aren’t getting any results from
your current activities, you need to
change you approach to one that may
be more productive. She also pointed out
that you shouldn’t overwhelm yourself
with more than three or four strategies
at once because you’ll dilute your focus
on the individual activities.

She also suggests that since job searching
is a very stressful activity, you should keep
to a regular schedule that includes time
doing online searching, time for network-
ing phone calls, time for leisure activities,
and time for spiritual renewal.

October 15: Using the Internet for Your
Job Search – Tod Pike
The Internet allows you to extend your
reach immensely, helping you find informa-
tion at any time or location. This has both
positive and negative implications for a job
search, since other people are also using
the Internet in the same way – they also
have the same benefits as you do. In the
past, using the Internet for job searches
was limited to high-tech workers and em-
ployers (the only ones with Internet access).
Unfortunately, the Internet is now a mass-
market tool that any person or company
can use, making the job search much more
difficult.

Tod discussed the different uses of the
Internet in your job search. Specialized job

search sites make their money from posting
job listings from companies, and let you
search for a job by location, keyword, and
date. If you are interested in a particular
location, Tod suggests searching by date
since you may miss some relevant job
postings if you search using a keyword dif-
ferent from those used in the posting. In
order to reduce the amount of time spent at
each site, you should search them frequently
– every few days at the least.

Another source of jobs is the career pages
of corporate websites. If you have some
companies that you’ve targeted as places
you’d like to work, go to their website, find
the career sections, and bookmark them. You
should check these pages at least once a
week. You may have more luck responding
to a job posted on a corporate site because
the company may not be using the big job
search sites, or may try to fill the position
from their own searching before resorting
to a post on the job search sites.

While not directly related to finding a job,
the Internet also excels at helping you find
out general information about corporations
or regions that can help you in your job
search.  General-purpose search sites, such
as Google or AltaVista, can help you locate
target companies in an area, find out more
information about life in a particular city, or
help you learn more about technologies of
interest to you.

The Internet is a vast resource for career
opportunities in general. Don’t overlook
on-line seminars, web broadcast (web
casts) and other ways of finding out about
new products and technologies. Look at
the corporate websites of companies that
market products or technologies of inter-
est for more information. Often, companies
put out demo or trial versions of their soft-
ware that you can download for free. Also,
there are numerous opportunities for
online education. The University of Phoe-
nix is almost entirely online, and most of

WorkQuestTM Group Going Strong

3. Start Word’s merge process and estab-
lish a connection to the database. You
can specify the database, the tables,
or queries you want to use as the data
source.

4. Insert the merge fields at various loca-
tions within the Word document.

5. Execute the merge. Word grabs the
specified content from the database
and fills out the document.

Conclusion
There are many ways to skin the single-
source cat using Microsoft Word. However,
consistency and discipline are crucial. If
you work with others who are responsible
for text that you rely on, be sure they stick
to a few simple conventions regarding file
names/locations, bookmark names,
graphic types, table sizes, etc. Remember,
if the source files should be renamed or
moved to another folder, then the links to
those files must be recreated to reflect the
new locations and names. A little instruc-
tion from you on chunking and organizing
content will be a big help to you in the
long run.

Relying on templates is also important and
you can add a level of automation in some
of your documents by starting from tem-
plates with the links to bookmarks or merge
fields that are already embedded in them.
Start a new document from a template,
press F9, or execute a merge, and presto!
Your new document suddenly comes alive
with pages of content.

Bob Mohr can be reached at
rpmohr@writemohr.com.

Single Source
Text with
Word—Sort Of
(continued from page 9)

(continued from page 5)

(continued on page 11)
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the local universities offer online versions
of courses.

October 22: Job Search Checklist –
Janis Ramey
Janis developed a checklist of job search
tasks, which includes activities related to
the startup of your job search (like listing
your job criteria, and identifying companies
where you’d like to work), activities perti-
nent to your active job search phase (like
attending networking meetings and mak-
ing cold calls), weekly tasks, and daily
tasks. If you use this checklist regularly, it
will be a great tool for keeping your job
search on track.

October 29: Networking Tips – Various
Lois Bradley, President of The Bradley Part-
nerships, along with co-presenters Deirdra
Makowiecki, of MAKK Strategies, and
Jonna Martin of AdvanceMe Associates,
gave a talk entitled “Tips for Networking to
Land that Next Career Opportunity”.

Lois Bradley’s career focus is management
consulting. She explained to the group that
nationally, networking is the way 60% of
people find their next job, but in Pittsburgh
the number is thought to be more in the
range of 80% to 85%. Networking is a very
important activity and should be the focus
of your job search. She stressed that net-
working should be a lifelong activity since
you need to have a good network in place if
you unexpectedly need to use it. The people
in your network can come from all facets of
your life: professional, recreational, family,
and church/community service.  Because
networking is so important, she suggests
preparing for networking like you would for
a job interview.  Make sure that you present
yourself well, and follow up with the people
you meet.

Deirdra Makowiecki consults for busi-
nesses and individuals on organization and
time management. She gave the group a
sample organizational chart that could be
applied toward job searching. She suggest-
ing making a list of your job hunting activi-

WorkQuestTM Group Going Strong

ties, prioritizing the list, and then being very
structured about scheduling the tasks
you’ve identified, giving more weight to the
high-priority tasks. Make everything that
you have to do an appointment with your-
self. Crossing things off of your list can
give you a sense of accomplishment.

Jonna Martin is an image consultant. She
stressed that your physical appearance
generates a powerful impression on people
who don’t know you.  You make your first
impression within seven seconds of meet-
ing someone.  Fifty-five percent of your
impression is visual, thirty-eight percent
is vocal, and only seven percent is based
on the content of your conversation. She
has seen statistics that the decision not to
hire someone is made within the first three
minutes of an interview.

She focused on some of the aspects of mak-
ing a good visual impression. She stressed
having good grooming and hygiene, wear-
ing clothes that are conservative (white
shirts and simple ties for men) and aren’t
out of style or dowdy, wearing cotton or
(for women) silk shirts, having your clothes
starched (if appropriate) and pressed neatly,
and wearing tasteful amounts of jewelry.
She told the group that when you meet
someone, you should be sure that your
posture is good, you have a firm handshake,
and you smile and focus on the person.
Talk about non-confrontational topics, and
end on a positive note when you leave that
person to meet someone else.

In closing, they presented the following
tips:

• Ask questions about activities in a
company you’ve targeted.

• Identify the company’s needs and try
to sell yourself to fill those needs.

• If you talk to someone who isn’t the
right person to get you into a job, see
if you can get the name of the person
you should be talking to.

• Follow-up with the people you talk to.

November 5: Networking Revisited – Jim
McCarty
Group member Jim McCarty provided a de-
tailed plan for developing a wide network
of possible job contacts. Jim gave the fol-
lowing figures on how people find their next
job:

• Internet Ads

• Newspaper Ads -- 20 to 25%

• Recruiters -- Collectively

• Temporary Agencies

• Job Fairs

• Other (like company websites)

• Networking -- 75 to 80%

Jim described networking as an organized
approach to developing contacts that can
help you find individuals who have the au-
thority to hire you. He said that many of
these networking contacts are casual. They
are seldom the decision-makers you even-
tually need to meet, but they can guide you
to the right people.

In order to network effectively, Jim suggests
developing a game plan. Prepare a market-
ing program to follow.  Prepare your mar-
keting materials, to include:

• An attractive business card

• A succinct profile, résumé, and cover
letter (or several versions of them)

• A list of target companies to contact

• A contact list, or list of persons who
know, including business acquaintan-
ces - this is a starting point for your
networking

Make contacts at networking groups and
start attending meetings.  Because meet-
ings are impromptu, you should always be
ready with a well-rehearsed, quick over-
view of what you do. This is often referred
to as the 30-second drill. Describe your
skill set - what you offer an employer - in

(continued from page 10)

(continued on page 12)
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30 seconds or less. The 30-second drill
should emphasize who you are, what you
have accomplished, what you can do for a
new employer, and what you want to do.

When you schedule a networking meeting
with someone in a targeted company, do
not leave a résumé. A networking interview
is not a job interview. It is a fact-finding
session, and the opportunity to sell your-
self to your referral who probably cannot
hire you, regardless. Instead of a résumé,
leave a one-page Profile Sheet, or Execu-
tive Summary. It should emphasize your
skills and major accomplishments, and
maybe a brief client list. Tell the interviewer
that you want to stay in contact with him or
her. After the interview, send a personal,
hand-written thank you note.

In your job search, Jim stresses keeping
good records. If you analyze the results
of your job search activities, you can pur-
sue the successful activities and omit the
unsuccessful ones. Some of his points
included:

• Develop a list of details (potential vari-
ables) you want to track. Start with
those listed above.

• Rank the importance of each, with respect
to contributing to success or failure.

• Determine how you will record and
track your performance. Use software
such as ACT, Excel, Outlook, etc.

• Evaluate the outcome of each interac-
tion to determine potential causes of
success and failure.

• Determine what elements might be
changed to produce better results.

If you’re not having much success in your
job search, Jim suggests that you try the
following:

• Make cold calls (by telephone and in
person) to develop leads and contacts.
Try to get names of key individuals,
including those in human resources

and purchasing, project managers, de-
partment heads, administrative manag-
ers, and executives. Be creative in your
approach with receptionists, secretar-
ies, and other gate-keepers.

• Check newspapers for company ar-
ticles and make contact based upon
that article.

• Check calendars of events in newspa-
pers and attend group meetings, such
as networking groups, associations,
conventions, etc.  Network as much as
you can.

• Maintain your networking contacts. A
good network will keep you employed.

WorkQuest
TM

 was formed as a resource for
you. Although the meetings are geared to-
ward writers, everyone who is looking for
work is welcome to attend the meetings.
Many interesting topics are planned for the
next month. Notices of the meetings can be
found on the WorkQuest

TM

 website http://
home.earthlink.net/~workquest/.

Employment Issues Column:
Marketing Yourself
(continued from page 3)

nent information on the person contacted,
the company, the content of your discus-
sion, and any action you need to take. Date
the logs. You never know when someone
you talked with two weeks ago will call you
with an appropriate job opening.

Follow Up
Always follow up on your visits or phone
calls with a letter thanking the person you
contacted.

Remain positive! A good attitude goes a
long way when looking for your next job.

[Editor’s Note: This column marks Pam
Schmidbauer’s last Employment Issues
column for the Blue Pencil.  The editorial
staff of the Blue Pencil and the officers of
the Pittsburgh chapter of the STC thank

her for her many contributions to this
newsletter. -MAP]

Pam Schmidbauer is Area Manager of
Aquent’s Pittsburgh office and can be
reached at pams@aquent.com or 412-322-
4940.  Aquent (aquent.com) is a global
professional service firm delivering cre-
ative and IT solutions. Through a network
of nearly seventy offices in twelve countries,
Aquent provides staffing, consulting, and
outsourcing services in the areas of print
and Web design and production; applica-
tion and database development;  and project
management. In its fifteen-year history
Aquent has made over 200,000 matches of
independent  professionals with client com-
panies worldwide. Aquent is headquartered
in Boston, Massachusetts, and is a privately
held firm.

(continued from page 11)
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Third Annual Worst Manual Contest
Just a reminder for the holiday season:
When all else fails, read the manual.

Have you ever been so frustrated with a
manual or set of instructions that you
cursed the author and wished you had
never bought the product in the first place?
Does this sound familiar? How about $100
for your frustration? Technical Standards,
Inc. (TSI), a Southern California documen-
tation services company, is offering $100
for the winning entry in their third annual
‘Worst Manual Contest.’

Send a manual or set of instructions that is
hard to understand, poorly written, or just
plain wrong.  Send it if it has bad grammar,

too much legalese, is poorly translated, or
has missing steps.  If it is the worst entry,
you will win $100.

“We thought we would have fun with this
contest.  Everyone has had trouble with a
manual,” says Michelle Wier, Director of
Operations of TSI. “That’s why we started
our company.  People like products they
understand how to use, and good techni-
cal documentation reduces the need for
technical support.  That’s why good
manuals are so important.”

You don’t have to send the whole manual;
excerpts of the worst parts are okay.  The
deadline for submissions is January 31, 2003,

so check those holiday gifts for potential
entries.  Entries must be in English.  For
complete contest rules, see the TSI website
at www.tecstandards.com.  The winner will
be announced on the TSI website on Feb-
ruary 28, 2003.

Technical Standards, Inc., specializes in
contract technical writing projects,
technical writer staffing, and training.
Since 1993 in San Marcos, CA, TSI has
provided writers and editors to the
high-tech community who produce
printed documents, online Help, and
Internet documentation.

TechComm

Experienced Technical Writer
Experienced Researcher

• Research Proposals

• Grant Proposals

• Contract Proposals

• Research Reports

• Articles

• Monographs

• Training Materials

Telephone: 412-343-2508

Wanted – Column Ideas
The Blue Pencil staff is looking for ideas for a new column to add to this newsletter.  Are there topics you would be interested in reading
about from month to month?  Better yet, would you like to volunteer to write a column?  (Length and frequency are flexible.)  Please contact
Meg Papa (mv0t@andrew.cmu.edu) with your ideas or offers of assistance.  Thank you very much.
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Editorial Calendar
This combined December/January Blue Pencil is the final issue of 2002.  Details of the January meeting will be mailed out via postcard.  For
2003, the editorial calendar will follow the schedule below.

Joint Meeting  Postponed
The joint meeting that was scheduled for Saturday, December 7 in Youngstown, Ohio, is
postponed until early 2003. Look for more details  on the chapter web site in a few weeks.

Independent and Lone Writers SIG
January Meeting
The next meeting for the Independents and
Lone Writers SIG will be Tuesday, January
28 at 6 p.m. at the Panera Bread Company in
Oakland.  The discussion for this meeting
will focus on issues that affect lone writers
in a company.

As the lone writer in a company, your re-
sponsibilities may not just focus on creat-
ing documentation and help, but you may
be part of other facets in the development
process.  This meeting will discuss some of
key issues that lone writers face along with
some resources and skills to help trouble-
shoot the challenges that arise for the lone
writer.  Everyone is encouraged to bring
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some of their own tips for survival as a lone
writer, along with software and reference
ideas to help others.

There is no cost for this meeting, but Panera
has great sandwiches, salads, soups and
pastries that you can purchase and enjoy
during the discussion.  Please RSVP to Barb
Stanton by Monday, January 27 to
Bstanton@seec.com or call (412) 893-0383.

Life Skills for Looking for Work

Mark your calendars!  Here are topics and tentative dates for the
remainder of the 2002-2003 meeting calendar.  More details on
each meeting will be published as the dates draw closer.

January — Winter Party (date to be determined)

February 11 (Tuesday) — Frame 7 (Kay Ethier)

The December chapter meeting will feature
four presentations by our own WorkQuest
special interest group. Whether you are
currently looking for work, or may some-
day look for work, you will find value in
these presentations.

John Clark: “Presenting Yourself”

Mary Ann Pike:  “Job Search Preparation”

Jim McCarty: “Finding Opportunities”

Diana Mathis: “Nurturing Topics”

Parking in the building is available for $5.00 at
the Westin Convention Center Hotel parking
garage. Parking is free during the holiday sea-
son at Pittsburgh Parking Authority garages.
The PPA garages at 9th Street and Penn Av-
enue and at 9th Street and Liberty Avenue are
within a few blocks of the meeting.

WHEN:  Tuesday, December 10,
2002

TIME:   6:00 - 8:00 p.m.

WHERE: Federated Investors,
Inc., 19th Floor, 1001 Liberty Ave.,
(Adjacent to the Westin Conven-
tion Center Hotel)

COST: There is no charge for this
meeting. Light refreshments will be
provided.

RSVP: An RSVP is REQUIRED
due to building security regula-
tions. Please contact Darlene
Mullenix at (412) 288-8676 or e-mail
to dmullenix@federatedinv.com

March 11 (Tuesday) — Chapter 50th Anniversary Party and Awards
Banquet (Janis Ramey)

April 8 (Tuesday) — Robohelp (Leslie Johnson)

May — Spring Fling Party (date to be determined)
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